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Lectora Workshop 
 
Commence the project 
 
1. Launch the programme.  You should find the application in the “Start” or “All 
Programs” menu under the heading “Lectora Enterprise Edition”. When you open the 
Lectora application you will see the following dialogue box. NB. The Lectora 2006 splash 
screen is only slightly different. 
 

 
 

Opening Dialogue Box 
 
There are four tabs to choose from: 
 

1. Title Wizard 
2. New Title 
3. Open Existing Title 
4. Templates 

 
First of all, you will explore creating a new title.
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2. Click on the New Title tab. You will see the following dialogue box. 
 

 
 
3. Type in a name for your new title. The title name for today’s project is “The Coral Reef”. 
 
Notice that the project is saved in the following directory or folder: C:\My Documents\My 
Titles\The Coral Reef\.  You can alter the directory if you wish. 
 
4. Click the OK button. You will see the window below. 
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Create the welcome page. 
 
Your project should look like this. You will see that your project is listed in the directory on 
the left. The first page is blank. Do not let this frighten you. All PowerPoint and text 
documents always start with a  blank page. Great works of art always commence with a 
blank canvas. It is simply called Page 1. 
 

 
 
1. Click on the text for ‘Page 1’ and change it to ‘Welcome’. It is wise to give each page 

and file in your project a unique and meaningful name. In fact, you may have difficulty 
publishing your project if there are files with identical names. Please give each file a 
unique name, such as “coral001”, “coral002”, “coral003”, etc. 
 

Now you will add a title banner to the project. Please follow these steps. 
 

 
 
 
2. Click on the ‘Add Image’ button located on the toolbar. It looks like a small camera. 
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The following window will appear. 
 

 
 
3. Change the name from ‘Image 1’ to ‘Title banner’. 
 
4. Click on the ‘Import’ button and simply browse through the directories to the ‘Lectora 
project resources’ folder on the desktop. 
 

 
 
5. Click on the ‘title’ folder within the directory and select the file ‘coral_title.jpg’. 
 
6. Click on the ‘Open’ button. The title image will appear across the top of your project. It 
should look like the graphic set out below. 
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This title banner should appear on each page of your project. At this point in time it will 
only appear on page 1. So, let’s change its hierarchy within the project.  
 

 
 
7. To change its hierarchical position within the project simply click/drag it to “The Coral 
Reef” icon at the top of the project directory. 
 
The directory should now look like this after you have dragged the Title banner to the top of 
the hierarchy in the project window on the left hand side of your project. 
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Add the navigation buttons 
 
You will need to set up a basic navigation system so that learners or users can: 
 

• Proceed from one page to the next and explore the web site. 
• Review previous pages. 
• Return to the ‘Home’ page of the web site. 
• Exit or quit the web site. 

 
1. Click on the Tools menu and select the “Button Wizard” menu item.  

 
The following window will appear. 
 

 
 

2. Click on the “Stock button from clipart’ radio button as shown below. 
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3. Click ‘Next’. 
 
The following window will appear. 
 

 
 
4. Scroll down the window and view all the buttons. Select four buttons (Back, Forward, 
Home and Exit) in a common theme. You can select more than one button at a time by 
click/holding the Control (Ctrl) button on your keyboard. 
 
In the example below the four “plasti” themed buttons were selected. 
 

 
 
5. Click Next. The following window will appear. 
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5. Change the spacing to 15 pixels. Leave the alignment as ‘Across’ as our buttons will 
positioned horizontally on the page. 

 
The four buttons will appear at the centre of your project page. All four buttons are selected. 
They have highlighted borders with small ‘handles’ at regular points. 
 

 
 
You can drag all four buttons at the same time while they are still in this selected state.  
 
7. Click and drag the buttons to the lower right hand corner of the project. 
 

 
 
8. Then click anywhere else on the project page to deselect the buttons. They should look 
like this on the white background of the project screen: 
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The buttons are fully functional. Your project directory should look like this. 
 

 
9. Please change the name of the buttons to “Next.gif’, ‘Home.gif’, ‘Exit.gif’ and ‘Back.gif’. 
How? Simply click on the button title, and alter the name while it is selected or use the 
backspace key to delete the characters. Then type the new name. 
 

 
 
You have successfully created and added a fully functional navigation system to your 
project. 
 
Add the welcome text 
 
Now, let’s add some welcome text and some navigation instructions for the learner. During 
this activity you will have two open applications on your personal computer: 
 

i. Lectora 
ii. Microsoft Word 

 
1. Open the ‘Lectora Project Resources’ folder on the desktop.  
 

 
 

2. Locate the ‘documents’ folder within and double click on the Microsoft Word document 
‘Welcome.doc’. 
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3. Select all of the text within that document and then select ‘Copy’ from the edit menu. 
Alternatively, you can type ‘Ctrl A’ followed by ‘Ctrl C’. 
 
4. Return to Lectora publisher by mouse clicking on its tab in the Task Bar at the foot of the 
computer display screen. 
 
5. Click on the Welcome’ page icon in the project directory on the left hand side. 
 
6. Go to the Edit menu and select Paste. Alternatively, you can simply type ‘Ctrl V’ which is 
the same as “Paste”. The following ‘Text object’ will appear in the top left hand corner of 
the screen. 
 

 
 

It looks a little messy as the text is on top of the graphic. We will tidy that up. 
 
Your project directory on the left hand side of your project will look like this. 
 

 
 
7. You need to reposition and resize the newly pasted text object. Drag the text block to a 
point below the banner with your mouse so that it is now located on the blank part of the 
work area. 
 
8. Click drag on the lower corner of the text object to enlarge it. Move your mouse over the 
borders of the text box. You can enlarge the text object when the small arrows appear over 
the border of the text object. 
 
You will notice that none of the ‘tabs’ that were present in the original word document are 
present in the text object. The ‘tabs’ and formatting are not preserved in the copy/paste 
operation from Microsoft Word to Lectora. 
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9. Click anywhere else on the project window to deselect the text object. 
 
10. Double click on the text object in order to edit the text.11. Format the text by setting tabs 
before the final four sentences that describe the functions of each of the four buttons. 
Remember, you can edit the text in a text box by double clicking within the text box. 
 
12. You can also apply a bold style to the heading and the word ‘navigation’.  
 

 
Text Editor Toolbar 

 
13. Change the font and size of the text to Verdana 10. The Verdana sans serif font is 
specifically designed to be read on a computer screen and web pages in particular. 
 
When you have finished the ‘Welcome’ page should look like the example below. 
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14. Copy and paste the ‘button’ graphic from the word document ‘Welcome.doc’. This 
graphic of the buttons will set up four buttons that look real but are not functional. 
 
15. Remember to drag the copy/pasted ‘button’ graphic to the appropriate place on the 
project screen to the left of the four text descriptions. 
 
Explore the Button properties 
 
When you click on each button the following Button properties window will appear. 
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The Button Properties window has five tabs across the top: 
 

i. General 
ii. Position and Size 

iii. On Click 
iv. Condition 
v. Fly In/Fly Out (Lectora 2003)(Replaced in Lectora 2006) 

vi. Transitions (New in Lectora 2006) 
 
Here is a screen shot of the 2006 button properties window. Notice the new tab and the 
added parameters for the General Tab. 
 

 
 

Button properties in Lectora 2006. 
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Click on each dialogue box Tab to view and explore the details on each of the other four 
tabs. These property tabs control the position, size, action and programming for each button. 
We will explore some of these features later. They are illustrated below. Take the time to 
check each of them out. What can you learn?  

 

 
 

“Position and Size” Tab in Button Properties Window 
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“On Click” Tab in Button Properties Window 

 

 
 

“Condition” Tab in Button Properties Window 
 

 
 

“Fly In/Fly Out” Tab in Button Properties Window. Note: This tab no longer exists in 
Lectora 2006. It has been replaced with the  ‘Transitions’ Tab. See below. 
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“Transitions” Tab in Button Properties Window. Note: This is a new addition to Lectora. It 
allows the user a great deal of control over the transition or change that takes place when the 
developer designs the button action. The transitions are similar to those found in PowerPoint 

and Widnows MoveieMaker. 
 

Add a chapter to the project 
 
1. Let’s add a Chapter to the project. Click on the ‘Add Chapter’ button located on the tool 
bar. It looks like a Green book. 
 

 
 

The new chapter will appear as follows, simply entitled Chapter 1 and it will automatically 
include a ‘Page 1’.  

 
 

2. Please rename Chapter 1 to “About” and Page 1 as “What”. This will be a page 
explaining “What are coral reefs?” 
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Create a new page 
 
We need to add some text to “What” page. As before, you will have two open applications 
on your personal computer: 
 
iii. Lectora 
iv. Microsoft Word 

 
1. Open the ‘Lectora Project Resources’ folder on the desktop or in the nominated folder on 
your computer. 

 

 
 

2. Locate the documents folder, open it, and double click on the Microsoft Word document 
entitled ‘What_is_a_coral_reef.doc’. 
 

 
3. Select all of the text within that document and then select ‘Copy’ from the edit menu. 
Alternatively, you can type ‘Ctrl A’ followed by ‘Ctrl C’. 
 
4. Return to Lectora publisher by clicking on its tab in the Task Bar at the foot of the screen 
of your computer display. 
 
5. Click on the ‘What’ page icon in the project directory on the left. 
 
6. Go to the Edit menu and select Paste. Alternatively, you can type ‘Ctrl V’. 
The following ‘Text object’ will appear in the top left hand corner of the screen. As before 
you will need to reposition and resize the text. 
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7. Resize the Text object and reposition it on the page by click-dragging the object. You 
should see the following page. 
 

 
 
8. Add a heading “What are Coral Reefs” to the new text object and above the first 
paragraph. Apply a bold font style to the heading. Format the text. Remember, you can edit 
the text inside a text box by double clicking within the text box. 
 

 
Text Editor Toolbar 

 
9. Change the font and size of the text to Verdana 10. 
 
10. There is too much text on this page for the learner to read. You can split the text over 
two pages by following these nine steps: 
 

i. Select, Copy and Paste the ‘What’ page in the directory on the left. 
ii. Rename the first ‘What’ page “What 1”. 

iii. Rename the second ‘What’ page ‘What 2’. 
 
iv. Select the ‘What 1’ page in the directory. 
v. Double click on the text object. 

vi. Select and delete the second paragraph. 
vii. Select the ‘What 2’ page in the directory. 

viii. Double click on the text object. 
ix. Select and delete the first paragraph. 
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When you finish the first of the two pages should look like this. There is too much white 
space and the image could be supported with an appropriate graphic. 
 

 
 
11. Let’s add an Image object to this page. Select the ‘What 1’ page icon in the directory on 
the left.  
 
12. Click on the Add Image button on the Toolbar. It looks like a tiny camera. 
 

 
 

13. The following dialogue box will appear. 
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14. Change the name from ‘Image 1’ to ‘Coral Reef 1’. 
 
15. Click on the ‘Import’ button and browse through the directories to the ‘Lectora project 
resources’ folder on the desktop. 
 

 
 
16. Click on the ‘images_jpg’ folder and select the file ‘coral_reef001.jpg’. 
 

 
 
17. Click on the ‘Open’ button. 
 
18. The coral reef image will appear at the top left hand corner of your project. Click drag 
and resize the image. The page should look similar to this. 
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19. Repeat the process for the page ‘What 2’ but please select a different image this time 
from the folder of images you explored in steps 15 and 16 earlier. Your directory should 
look like this at the end of this task: 
 

 
 

 
 
[Note: Have you saved your project? Click on the floppy disk icon in the toolbar or select “Save Title” from 
the File menu. You can preview project by selecting the Preview mode button. Type ‘Esc’ to return.] 
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Adding additional media objects 
 
Now we are going to add a variety of different objects to a sequence of pages. You have 
already added three different images to your project. You are quite experienced with adding, 
positioning and resizing objects now. Follow these steps. 
 
1. Click on the ‘What 2’ page icon in the directory on the left. 
2. Click on the ‘Add Page’ icon in the Toolbar. 
 

 
             ^ 

The page icon “What 3” should appear beneath the “What 2” page icon in the directory on 
the left. Repeat this process seven times. You should have eight additional pages numbered 
from 3 to 8 in the directory. Lectora is “intelligent” enough to name and number the 
additional pages. 
 
3. You will need to complete the following four specific actions for each of the eight 
additional pages: 
 

i. Rename the page 
ii. Select the page 

iii. Add a specific media object to that page. The media files will be located in the 
Lectora Project Resources folder. 

iv. Reposition the image to the centre of the page 
 
4. You will be required to add a new object to each page. Each object will be different. Your 
instructions for each page are set out in the table below. 
 

Page name 
Rename 

and select 
page 

Click on 
Toolbar 
object 

Name of source 
file folder and file  

type 

Name of source file to 
import into your project 

What 3 
 gif Add Image images_gif fish.gif 

What 4 
 flash Add Animation flash 

coral.swf (Note: You must 
resize and enlarge the flash 
file. It only works during 
Preview or Run mode) 

What 5 
 mov Add Video mov ClamOpening.mov 

What 6 
 mpeg Add Video mpeg Tulip.mpg 

What 7 
 qtvr Add Video qtvr 

coral_001.mov (Note: your pc 
may not have QuicktimeVR 
plug-in installed) 

What 8 
 ipix Add Ipix ipix coral.ipx (Note: your pc may 

not have ipix plug-in installed) 
What 9 
 rtf Add Document rtf What_lives_on_coral_reefs.rtf 

What 10 audio Add Audio audio ocean_001.aif 
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When you have finished this exercise you should have a directory that resembles the one 
illustrated below on the left. You will now make additional changes that are set out below, 
so that the project directory resembles that shown on the right. 
 

                              
Before                                                             After 

 
5. Let’s configure each object on the eight different pages that you have just created. 
Perform the following changes for each object. 

 
Page name Double click 

on object  
Action to perform within the properties dialogue box 

gif Image 1 Rename ‘fish’ 
Select checkbox “Size and position locked” 
Select tab Fly In/Fly Out: Select both check boxes 
Fly in from “Left” and Fly out to “Right” 

flash Animation 1 Rename ‘coral’ 
mov Video 1 Rename “Coral Mov” and Select “Display Video Controller” 
mpeg Video 1 Rename “Coral mpeg” 

Select “Display Video Controller” 
Select “Auto Start” 

qtvr* Video 1 Rename “Coral qtvr” 
Select “Auto Start” 
Select “Play Continuously” 

ipix* IPIX 1 Rename “Aquarium” 
Select “Use Java Runtime when exporting to HTML” 
Select “Size/position locked” 

document Document 1 Rename “scroll text” and Select “Size/position locked” 
audio Audio 1 Rename “ocean” 

Select menu item “Display Controller” 
Select “Auto Start” 

 
*Note: Not all computers may play the qtvr or ipix files if the plug-in is not installed. 
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Adding rollover effects 
 
In this task four image objects will act as hot spots that show and hide four text objects. 
When you roll your mouse over an image object it will show a text object. When your roll 
your mouse out of the same image object the corresponding text object will then be hidden. 
This allows you to create a page rich in information. 
 
Step A: Importing the four rollover images. 
 

1. Click once on the About chapter icon in the directory in order to select that chapter. 
2. Click on the “New Chapter” icon in the toolbar. 
3. Rename the new chapter “Actions” 
4. Rename Page 1 “rollovers” 
5. Import the four images illustrated below from the folder named ‘rollover’ in the 

Lectora Workshop Resources folder and neatly set them out in a horizontal row 
across the top of the new page “rollovers” 

6. Name each new image “food”, “medicine”, “shelter” and “tourism”. 
 

Food.jpg 
 

Medicine.jpg Shelter.jpg Tourism.jpg 

    
 
Step B: Adding the four text blocks or text objects that will be revealed and hidden by the 
rollover buttons. 
 

1. Add four new text objects by clicking on the “Add Text Block” button. 
2. Name each new text block “foodtext”, “medicinetext”, “sheltertext” and 

“tourismtext” respectively. Hint: It is recommended that objects do not share the 
same name. 

3. Click on each text object in the directory so that you can reposition and resize each 
text object beneath the row of four buttons. Position each object so that they do not 
cover each other. This will allow you to copy and paste the text. 

4. Open the “Why_are_coral_reefs_important.doc”. It has textual information on each 
of the four topics. 

5. Copy and paste the “Food” paragraph from the word document 
6. Return to Lectora publisher by clicking on its tab in the Task Bar at the foot of the 

screen on the computer display using the mouse. 
7. Select the ‘foodtext’ text object in the project directory. 
8. Double click inside the ‘foodtext’ text object. 
9. Go to the Edit menu and select Paste. Alternatively, you can type ‘Ctrl V’. 
10. Resize and reformat the text inside the text block as appropriate. Verdana Font Size 

10. 
11. Repeat this process for the ‘medicinetext’, ‘sheltertext’ and ‘tourismtext’ text objects. 

Step C: Positioning and resizing the four text objects. 
 
You will need to reposition the text objects as they may all be pasted in a haphazard, messy 
manner in the project window. The best way to work with such a large number of objects is 
to click on their icon in the project hierarchy menu on the left. See below. 
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1. Select each of the four text objects, by clicking on each in turn, in the hierarchy menu on 
the left, and neatly place and position them one above the other. Another way to achieve 
this is to (and I feel by far the most effective way): 
 

i. Double click on each of the four text objects in the project directory in turn. 
ii. Click on the “Position and Size” Tab 

iii. Set the position parameters as X = 50 and Y = 200 
iv. Set the size parameters as Width = 500 and Height = 200 
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Step D: Hiding the four text objects 
 
Double click each of the four text objects in the project directory in turn to reveal the 
Properties window and deselect the “Initially visible” check box. This will hide each of the 
four text objects. 
 

 
 

Step E: Adding the “show” and “hide” rollover effect 
 
1. Select each of the following four image objects in turn: 
 

1. “food” 
2. “medicine” 
3. “shelter” 
4. “tourism” 

2. Click on the Add Action button in the Toolbar.                  The following Action 
Properties window will appear. 
 

 
3. Change the settings in the Action Properties window as follows: 
 

Action Name: show[name of image object][see below for example] 
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On: Mouse Enter 
Action: Show 
Target: [the name of the matching text object: example “foodtext” 
 
The example below is the “showfood” Action applied to the “food” image. 

  

 
 
5. Click OK. 
 
6. Add a second action to each of the four image objects in turn. 
 
7. Change the settings for the second action as follows: 
 

Action Name: hide[name of image object][see below for example] 
On: Mouse Exit 
Action: Hide 
Target: [the name of the matching text object: example “foodtext” 
Click OK. 

 
 

Refer to the illustration on the following page. 
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 The example below is the “hidefood” Action applied to the “food” image. 
 

 

 
 
Your project directory should resemble this: 
 

 
 
Do the actions work? Check your work in the preview mode.
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Adding additional button interactivity 
 
Now you are going to explore an additional feature that you can apply to buttons. Simply 
follow each step in turn. 
 

1. Create a new chapter and name it More Actions. 
2. Click on the Page 1 icon of that new chapter in the directory. 
3. Select “Button Wizard” from the Tools menu. 
4. Select a custom button with text 
5. Click Next. 
6. Click on the ‘Single Button’ radio button 
7. Click Next. 
8. Enter a name for your button. 
9. Choose a colour and font for your button. 
10. Click Finish 
11. Double click on the new button to reveal the Button Properties window. 
12. Click on the ‘On Click’ Tab. 
13. Enter these settings: 

o Action: Display message 
o Message to display: “This is a popup alert.” 
o Click OK. 
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Display a popup window 
 
Now you are going to explore another additional feature that you can apply to buttons. 
Simply follow each step in turn. 
 

1. Click on the Page 1 icon in the directory. 
2. Click on the Add Page button in the Toolbar. 
3. Name the new page “Popup Page” 
4. Select “Button Wizard” from the Tools menu. 
5. Select a custom button with text. 
6. Click Next. 
7. Click on the ‘Single Button’ radio button. 
8. Click Next. 
9. Enter a name for your button. 
10. Choose a colour and font for your button. 
11. Click Finish 
12. Double click on the new button to reveal the Button Properties window. 
13. Click on the ‘On Click’ Tab. 
14. Enter these settings: 

o Action: Go To 
o Target: Chapter, Section or Page 
o Name: Popup Page 
o Scroll to: Top of Page 
o Check the box: Open In New Window 
o Click OK 
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Toggle Visibility 
 
It is possible to alter the visibility state of an image. This function could be used to hide a 
graphic and so reveal a second graphic that was placed “underneath” the hidden graphic. 
This process could be used to illustrate changes in a circuit following switching, a “before-
after” scenario or the impact of structural change. Can you think of any other applications 
for this technique? 
 
How to achieve this? 
 

a. Import a graphic or other object that can have its visibility toggled. 
b. Create a button and modify its On Click property so that it performs the action 

“Toggle Visibility State”. 
 
So… to begin this activity: 
 
1. Add an Image object to this page. Select the “page” icon in the directory on the left.  
 
2. Click on the Add Image button on the Toolbar. It looks like a tiny camera. 
 

 
 

3. The following dialogue box will appear. 
 

 
 
4. Change the name from ‘Image 1’ to “Starfish” 
5. Click on the ‘Import’ button and browse to the ‘Lectora' project resources’ folder on the 
desktop or on the “D” drive of you PC. 
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6. Click on the ‘images_jpg’ folder and select one of the files, for example, ‘starfish’. 
 
7. Click on the ‘Open’ button. 
 
8. The starfish image will appear at the top left hand corner of your project. Click drag and 
resize the image. Drag it to the right hand side of the screen. 
 
9. Add a button using the button wizard. Select button wizard from the Tools menu. 
 

• Select a custom button with text. 
• Click Next. 
• Click on the ‘Single Button’ radio button. 
• Click Next. 
• Enter a name for your button: “Toggle Image” 
• Choose a colour and font for your button. 
• Click Finish 

 
10. Double click on the new button to reveal the Button Properties window. 
 
11. Click on the ‘On Click’ Tab. 
 
12. Set the Action to “Toggle Visibility State”. Refer to the example below. 
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14. Test your new action in Preview or Run mode. 
 
Activity: 
 

1. Using Google, or another search engine such as Vivisimo or Kartoo, look for some 
before and after examples on the Internet. Examples of terms you might use in your 
search might include “before”, “after”, “examples”, “impact”, “see”, “difference”, 
“effect”, “obvious” and so on. 

2. Import both images into your Lectora project. 
3. Name each image… ‘before’ and ‘after’. Ensure that the before image is placed 

“above” the “after” image on the screen. 
4. Create a button that alters the visibility of the “before” image. 
5. Test your results in Preview or Run mode. 

 
 

http://www.google.com/ 
 

http://www.vivisimo.com/ 
 

http://www.kartoo.com/ 
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Change the contents of an object on the screen 
 
This action is not unlike the Toggle Visibility action. How to achieve this action? 
 

1. Import or create an object on the page. 
2. Create a button that changes the contents of that object when clicked. 

 
So to begin… 
 
So… to begin this activity: 
 
1. Create a new page.  Add an Image object to this page. Select the new “page” icon in the 
directory on the left.  
 
2. Click on the Add Image button on the Toolbar. It looks like a tiny camera. 
 

 
 

3. The following dialogue box will appear. 
 

 
 
4. Change the name from ‘Image 1’ to “crab” 
 
5. Click on the ‘Import’ button and browse to the ‘Lectora project resources’ folder on the 
desktop or on the “D” drive of you PC. 
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6. Click on the ‘images_jpg’ folder and select one of the files “crab”. 
 
7. Click on the ‘Open’ button. 
 
8. The crab image will appear at the top left hand corner of your project. Click drag and 
resize the image. Drag it to the right hand side of the screen.  
 
9. Name your image “Crab 1”. 
 
10. Add a button using the button wizard. Select button wizard from the Tools menu. 
 

• Select a custom button with text. 
• Click Next. 
• Click on the ‘Single Button’ radio button. 
• Click Next. 
• Enter a name for your button: “View second crab” 
• Choose a colour and font for your button. 
• Click Finish 

 
11. Double click on the new button to reveal the Button Properties window. 
 
12. Click on the ‘On Click’ Tab. 
 
13. Set the Action to “Change Contents”. Refer to the example below. 
 
14. “Import” a second crab image that will be used to change the contents of the first crab 
image. Refer to the example below. 
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15. Test your new action in Preview or Run mode. 
 
Let’s try this action using a Rich Text Format document object. 
 
1. Create a new page. Add a Document object to this page. Select the new “page” icon in the 
directory on the left.  
 
2. Click on the Add Document button on the Toolbar. It looks like a tiny page of text. 
 

 
 
 

3. Import the Rich Text Format document “What_lives_on_coral_reefs.rtf” from the rtf 
folder in the Lectora Workshop Resources folder on your PC. Move the document to an 
appropriate position on the screen. 
 
4. Create a second RTF document on your PC. Give it a name that you can remember. 
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5. Add a button using the button wizard. Select button wizard from the Tools menu. 
 

• Select a custom button with text. 
• Click Next. 
• Click on the ‘Single Button’ radio button. 
• Click Next. 
• Enter a name for your button: “Change text contents” 
• Choose a colour and font for your button. 
• Click Finish 

 
6. Double click on the new button to reveal the Button Properties window. 
 
7. Click on the ‘On Click’ Tab. 
 
8. Set the Action to “Change Contents”. Refer to the example below. Remember to select a 
target and to import its replacement. 
 
9. Test your new action in Preview or Run mode. 
 
Pop up window (alternative method) 
 
1. Create a brand new page, for example ‘Page 4’, with the following features: 
 

• A suitable heading 
• Some text 
• An image 
• A single button in the bottom right hand corner 
• Name the page “Page 4” 

 
2. Double click on the new button to reveal the Button Properties window. 
 
3. Click on the ‘On Click’ Tab. 
 
4. Set the Action to “Exit Title/Close Window”. Refer to the example below. 
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5. Go to any other page in your project and add a new button using the button wizard. Select 
button wizard from the Tools menu. 
 

• Select a custom button with text. Click Next. 
• Click on the ‘Single Button’ radio button. Click Next. 
• Enter a name for your button: “Show Page 4” 
• Choose a colour and font for your button. Click Finish. 

 
6. Double click on the new button to reveal the Button Properties window. 
7. Click on the ‘On Click’ Tab. 
 
8. Set the properties for the new button as follows.  
 

 
 

9. Click on the “Window Properties” button and set the properties as follows: 
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10. Click OK and test your button in Preview or Run mode. 
 
Automating actions  
 
It is possible to automate some actions. Essentially this is done by adding an Action to an 
object, including pages, that is triggered when one of the following events occur: 
 

• On Mouse Click 
• On Mouse Double Click 
• On Mouse Enter 
• On Mouse Leave 
• Show 
• Keystroke 

 
If you wish to make actions appear to be quite “automated” it would be best to use the 
“Show” event to trigger the action. 
 
For example, you could trigger some events to occur when a page opens. Follow these steps. 
 
1. Create a new chapter. 

 
a. Add two functional navigation buttons (“previous” and “next”) 
b. Create a few pages. 
c. Click on the second page. Does it have navigation buttons? 
d. Add an audio file to this page. (Memories1.mp3) 
e. Add an image to this page. (fish)(fish003.jpg)(Set the Fly-In properties as well! 

^_^) 
 
2. Select the second page icon in the new Chapter directory. 
 

a. Add an Action to this page. 
b. Change the parameters for the Action to: 

i. On: Show 
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ii. Action: Play 
iii. Target: Memories audio (audio 1) 
iv. Delay before action: 2 seconds 

 
3. Select the second page icon in the new Chapter directory a second time. 
 

a. Add a second Action to this page. 
b. Change the parameters for the Action to: 

i. On: Show 
ii. Action: Show 

iii. Target: fish 
iv. Delay before action: 2 seconds 

 
4. Go to preview mode or run mode and navigate between the pages to see the automation 

function. 
 
Linking to an external web site 
 
Simply follow these steps: 
 
1. Go to any other page in your project and add a new button using the button wizard.  
 
2. Select a custom button with text.  
 
3. Click Next. 
 
4. Click on the ‘Single Button’ radio button.  
 
5. Click Next. 
 
6. Enter a name for your button: “Launch web site” 
 
7. Choose a colour and font for your button. 
 
8. Click Finish. 
 
9. Double click on the new button to reveal the Button Properties window. 
 
10. Click on the ‘On Click’ Tab. 
 
11. Set the properties for the new button as follows.  
 

• Action: Go To 
• Target: Web Address 
• Web address: http://www.lectora.com 
• Select “Open new window” 

 
12. Try out your new button in preview or run mode. 
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Finishing the project 
 
It is time to finish the main project. The initial ‘previous’ button and the final ‘next’ button 
must not be functional as they will not take the learner or user to a page if clicked. 
 
1. Double click on the Welcome page icon in the Project directory. You can also right click 
on the Welcome page icon in the Project directory. Select the Properties item from the 
popup menu. The following Properties window will appear. 
 

 
 

2. Change the settings under the Inherit tab as follows: 
 

i. Select the “Exclude Inheritance of Certain Objects” 
ii. Click on “Back.gif” 

iii. Click the top button so that the “Back.gif” is in the Excluded window. 
iv. Click OK 

 
The ‘Previous’ button will no longer appear on the Welcome page. 
 
3. Repeat the process for the “Popup” at the bottom of the Project directory with these 
settings: 
 

v. Select the “Exclude Inheritance of Certain Objects” 
vi. Click on “Next.gif” 

vii. Click the top button so that the “Next.gif” is in the Excluded window. 
viii. Click OK 

 
The ‘Next’ button will no longer appear on the Welcome page. 
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Publish your project 
 
1. Select “Publish to HTML’ from the Publish menu. 
 
An error check will be performed. You may need assistance with this. Each listed error is 
described and is linked to the page with the specific error. 
 
2. Once the error check is complete you may then click on the Publish button. 
3. Remove any unnecessary files. 
4. Click on OK for the HTML location window. 
5. Click Done. 
 
You may like to experiment with other Publish modes. 
 

• Publish to Single File Executable 
• Publish to CDRom 

 
New Features and updates for Lectora 2006 
 
Lectora 2006 now allows users to add arrows and shapes to their project pages. Like all 
objects or elements in Lectora these objects also have a range of properties. 
 

 
 
  Arrows 
 

 
 

Shapes 
 

Each title and page have their own set or properties which you should find very useful. See 
below. 
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Title Properties 
 

 
 

Title Properties: General Tab 
 

 
 

Title Properties: Background Tab 
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Title Properties: Content Tab 
 
 

 
 

Title Properties: Frames Tab 
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Title Properties: Additional Files 
 

 
 

Title Properties: Author Control 
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Title Properties: Transitions 
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Page Properties 
 

 
 

Page Properties: General Tab 
 

 
Page Properties: Background Tab 
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Page Properties: Inherit Tab 

 
 

 
Page Properties: Transitions Tab 

 
 



http://blog.larkin.net.au/ Page 49 
 

 Some rights reserved: http://creativecommons.org/licenses/by-nc-sa/3.0/ 

 

 
Page Properties: Metadata Tab 
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Designing for the web 
 
Publishing 
 
Consider the lessons of the past 

 
• Web pages are a novel form of media in terms of presenting information to users 

however designers can adopt conventional information structures developed and 
evolved for the organisation of printed books and periodicals. 

• Do not ignore the basic standards of publishing, editorial and graphic design in 
creating your web pages. 

• Consider design precedents in the print world. 
• There is a place for such inclusions as contents, page numbering and indexes. 
 

And do not forget the present... 
 

• Develop the content for the Web first. 
• Create new and original content...do not recycle the old. 
• If you wish to publish the content then modify the text and images to modify it 

into a form that is suitable for print.  
 
Each web page should be able to live on its own 

 
• Consider that users can arrive at your web page via a bookmark, a link from a list 

of search results or from a hypertext link from an independent source. 
• When users arrive at your page they should be able to identify quickly where 

they are. 
• Accordingly headers, footers and the title should clearly and concisely describe 

the source, author and nature of the site.  These cues should be applied 
consistently across the site. 

 
Make the page easy to read 

 
• Very few users read every word on a web page 
• Most users scan the web page 
• So....design a web page users can scan quickly by using 

• highlighted keywords 
• appropriately named sub headings 
• lists 
• paragraphs that encapsulate a single idea 
• avoid hyperbole and jargon 
• credibility 

• Web design works by allowing the user to manipulate the information (by  
scrolling or clicking). 
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Information structure should be easily grasped by the user 
 
• Provide an easily understood and acquired information structure 
• The site structure should be designed according to the tasks users want to 

perform 
• Develop an efficient information structure 
• Simplify the hierarchy 
• Present a limited number of menu choices...say 7. 
• Incorporate nested menus 

 
Who is the author? 

 
• Accurately indicate who is responsible for the authorship of the material 
• Establish credibility and legitimacy for your site 
 

What is the page about? 
 
• Ensure the page title and document title succinctly describes the web page 

contents 
• The title is the first thing the user sees 
• It becomes the name of a bookmark 
• It can also be the name of the link 
 

When was the page created or modified? 
 
• Indicate page modification dates 
• Give users a clear sense of the currency of a page 
 

Cost 
• The annual maintenance budget for a web site should be about the same as the 

initial cost of building the site, with 50 percent as an absolute minimum 
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Interface Issues 
 
User-centered design 

 
• Empower the user 
• Engage the users 
• Give the user control 
• Test on a variety of users: novice through to experienced 
• Secure user feedback at all stages in the evolution of the site 

 
Design clear navigation aids and mobility cues 

 
• Always allow the users to know where they are. 
• Include links to the home page and a site map on each page 
• Your site map should reflect the information structure of the web site 
• Construct a 'You are here:" style navigation menu 
• Provide context or lose the reader 
• Consider the "Three clicks and you are lost" axiom 
• Include the url of the home page on each page 
• Ensure navigation icons are clear and easy to comprehend in terms of metaphor 

and visual literacy. 
• Make it easy for the user to get to the home page or site map. 
• Ensure you use standard link colours 
• Where possible allow users to quickly move backwards and forwards within the 

site via the strategic and judicious use of navigation links 
• Employ navigation bars that allow users to 'page' backwards and forwards 

through your site in sequential order 
• Do not lock your users out of the rest of your site 
 

Maintain a sense of simplicity and consistency 
 
• Do not allow pointless or over the top graphics to creep into your design 
• Employ easily understood metaphors 
• Allow users easy access to the information in terms of time and place 
• Modularise your site content 
• Employ consistent templates 
• Allow the user to chance to predict what they will see....do not keep them 

guessing 
• Keep titles, sub-titles and text consistent in its look and feel 
 

Stability of the overall design 
 
• Do it right 
• Check your links...particularly external links 
• Keep it neat 
• Ensure reliability 
• High editorial standards 
• Employ a single designer or a single design team 
 

Allow for user feedback and dialogue 
 
• Can your user communicate with you? 
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• Do you have forms that the user can complete? 
• Is there a site evaluation page? 
 

Consider the needs of the disabled 
 
• Make use of "alt" tags for graphic elements, rules and tables. 
• Design a text only mirror of your site 
• Allow easy access for users with text readers 
• World Wide Web Access:Disability Discrimination Act Advisory Notes Version 

2.1 (July 1998) 
• Bobby: Online verification of the accessibility of your web pages 

 
Kill the dead ends within your site 

 
• All pages should have at least one link 
• Eliminate orphans from your web site 
• Remove redundant pages from the web server 
 

Things to avoid when creating web pages 
 

• Forgetting why you are creating the web page. 
• Forgetting the identity of your users 
• Designing for your boss or employer 
• Frustrating users with inconsistent screen elements 
• Frustrating users with constantly changing page layouts 
• Losing opportunities for links to other pages or external sites 
• Avoid endless animations and scrolling text 
• Try and keep urls simple 
• Insufficient navigation cues 
• Do not have pages that scroll forever 
• Do not have home pages with dimensions that exceed the size of typical browser 

windows 
• Avoid redundant or outdated information 
• Do not rely on frames since... 

• No bookmarking is possible 
• Difficulty with printing 
• Links may not work 

• Stick to mainstream content. Avoid the latest and the greatest in technological 
advances until it is appropriate or functional. 
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Technology and Software Issues 
 
Consider download times 

 
• Do not forget the bandwidth enjoyed by your typical user 
• Consider the end user: the general public or an employee on an intranet 
• Build pages that can download quickly 
• Provide alternative text only pages 
• Give users a choice with respect to multimedia and large files 

 
Macintosh/PC Compatibility Issues 
 

• Employ appropriate fonts (Arial, Helvetica, Times, Times New Roman, etc) 
• Employ Web 216 colour palette where possible 
• Check web site across different browsers and different versions (Netscape, 

Internet Explorer, etc) 
• Bobby: Online verification of the browser compatibilty of your web pages 
 

http://www.cast.org/bobby/ 
 
Internet Links 
 

useit.com: Jakob Nielsen's Website 
 

http://www.useit.com/ 
 
Recommended books 
 

http://www.useit.com/books/ 
 
Yale C/AIM Web Style Guide 
 

http://www.webstyleguide.com/ 
 

Browser compatibility and accessibility: Bobby 
 
http://www.cast.org/bobby/ 


